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MORE 3.1 ENHANCEMENTS

MORE 3.1 is a powerful outlining and
presentation program with several new features
and enhancements. MORE 3.1 is compatible
with System 7.0 and takes advantage of many of
the System 7.0 features including TrueType™,
Virtual Memory, and Balloon Help.

Other MORE 3.1 features include:

• Interruptible screen refreshing in Bullet Chart
View

• Movable modal dialog boxes

• Ability to clear rules from multiple headlines

• Upward shadows

In addition to describing the new More 3.1 features, this
Upgrade Guide describes how to install MORE 3.1. The
Upgrade Guide also has information that became
available too late to be added to the MORE 3.0 manuals.
For more information on using MORE 3.1, refer to the
MORE 3.0 manuals.

Note: If you are upgrading from MORE version 1.x or
MORE II, the MORE 3.1 READ ME file has a quick
overview of the MORE 3.1 features and answers
some common upgrade questions.

INTRODUCTION:

Welcome to MORE 3.1
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BEFORE INSTALLING MORE 3.1

Before installing MORE 3.1, please take the time to complete and mail the
MORE 3.1 Registration Card. Whether you have purchased MORE for the
first time, or have upgraded from a previous version, it is important to
send in the registration card. The registration card is located in the
Customer Service Plan included in the MORE 3.1 package.

Registering MORE 3.1 allows Symantec to keep you informed of future
updates and special offers, and entitles you to start receiving the
Symantec Magazine—a free magazine with helpful tips and hints on using
all the Symantec products.

When filling out the registration card, please take a few minutes to
complete the Personal System Information on page nine of the Customer
Service Plan. This information helps our support analysts, and saves you
time if you need to call for assistance.

Basic System Requirements for MORE 3.1

• At least one 800K floppy drive and hard drive

• At least 1MB of RAM

• System 6.0 or later

` NOTE: See Chapter 2 in Learning More 3.0 for more
information on system requirements.

INSTALLING MORE 3.1

Installing MORE 3.1 does not affect any existing MORE 3.0 program files.
You must use the Installer Program to copy the files to your hard drive as
the MORE 3.1 program files are compressed on the disks.

To install MORE 3.1:

1. Slide the disk tab lock in the upper-corner of the disk to the top
of the disk. The tab lock should appear open. This protects the
files on the disk so that they cannot be overwritten or erased.

2. Insert MORE 3.1 Disk #1 into the disk drive.

3. Double-click on the MORE 3.1 Installer Icon.

4. Follow the directions on screen.
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NEW MORE 3.1 FEATURES

This section explains the new MORE 3.1 features and enhancements. For
more information on a specific feature, see your MORE 3.0 manuals.

▼  System 7.0 Features

MORE 3.1 is compatible with System 7.0 for the Macintosh. You must
have System 7.0 installed on your computer to take advantage of these
features.

NOTE: For more information on System 7.0, refer to the System 7.0 user
manuals.

▼  System 7.0 Balloon Help

Balloon help gives you brief descriptions of commands or items on
screen. The descriptions appear in little balloons beside each item as the
cursor passes over them. For example, here is the balloon for the
Decimal
Tab Well.

Balloon Help
for the
Decimal Tab
Well

NOTE: Because balloon help slows down the performance of an
application, it is not recommended that you enable balloon help if
you are using a Mac Plus, Mac SE, or Mac Classic. If you need an on
screen help system for such a system, turn on MORE’s help dialogs.
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▼  System 7.0 Virtual Memory

Virtual memory allows you to increase the amount of RAM (Random
Access Memory) in your computer without having to add extra RAM
chips. Virtual memory makes a part of your hard drive act like RAM
memory—this can greatly increase the amount of memory available to
any program.

To use Virtual Memory, you must be using a Mac IIfx, IIcx, IIci, IIsi, Mac
SE/30, or Mac II with a PMMU chip. To set Virtual Memory, choose the
Memory icon in the Control Panel folder.

NOTE: Changes made to Virtual Memory do not take effect until the
computer is restarted.

▼  System 7.0 TrueType

TrueType™ fonts are fonts that give a good representation on screen, or
printed, regardless of the font size. This helps do away with the jagged
edges seen on larger font sizes. MORE 3.1 uses TrueType to represent
both on screen and printed fonts.

Two Samples of
On-screen Type:

Normal (jagged) A
(Left) and

TrueType A (Right)
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▼  System 7.0 Aliases

An alias is a file icon that contains the path or location of an original file.
The alias can be stored anywhere on the hard drive—by double-clicking
on the alias you can launch the original program or file.

Using an alias can be especially useful with MORE 3.1 because MORE
generally needs all the program files in the same folder. Now you can
create an alias of the program file and move it anywhere on a hard drive
and MORE 3.1 will still be able to locate the original files in the MORE
3.1 folder. You can use aliases for the MORE 3.1 dictionary files, help
files, options files, balloon help files, and even the MORE 3.1 folder.

To create an alias, select the file you want to create an alias for in the
Finder. Choose Make Alias from the File Menu. The alias appears as a
new file icon with the name of the file in italics and “alias” as the last part
of the file name.

▼  Interruptible Screen Drawing in Bullet Chart View

The interruptible drawing feature permits editing operations to be
performed even while the screen is being updated. This is a useful time
saving feature when making multiple changes to a complex bullet chart.
To stop the bullet chart screen from being redrawn, simply click the
mouse or press any key on the keyboard.

▼  Movable Modal Dialog Boxes

MORE 3.1 allows most of the dialogs that appear on screen to be moved.
This keeps dialogs from obstructing the view on any MORE screen. To
move a dialog, drag the title bar at the top of the dialog to another
location.
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Upward Shadows

Upward shadows are now available for bullet charts, tree charts, text,
lines and so on. There are now 24 shadow styles to choose from
including the new upward shadows as shown in the following
illustration.

The Shadow
Menu

Clear Rules From Multiple Headlines

MORE 3.1 allows you to clear rules from multiple headlines. Rules define
the format and style of a headline in your document—each headline can
have a different set of rules. By clearing the rules, the Home headline
rules are reapplied to the selected headlines. To clear rules from multiple
headlines, follow these steps:

1. Hold down the shift key and click in the selection bar next to
any headline that has rules attached to it (to clear all rules from
the outline, choose Select All from the Edit menu).

2. Hold down the Option key and choose Clear Rules from the Edit
Menu.

NOTE: It is possible to clear the rules from the Home headline.
When the Home headline's rule is cleared, MORE 3.1 uses
default values to format the outline.
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MacPaint Import Utility

The MacPaint Import Utility allows you to select a portion of a MacPaint
file to be imported into MORE 3.1. When importing a MacPaint file, the
MacPaint Import Utility automatically appears as shown in the following
illustration.

The MacPaint
Import Utility
dialog box

To select a portion of the screen:

1. Drag the cursor around the portion of the screen you want
imported. A highlight box appears around the text.

2. Click Import.

Optionally, select any of the following options:

• Click Matte to choose the area of the graphic to import (this is
similar to selecting the image inside the selection box).

• Click Reverse to make the black pixels erase whatever is behind
them on the screen (for example, black to white)

• Click Transparent to make the white space transparent
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▼  MORE 3.1 Libraries

MORE 3.1 comes with several libraries with different templates and clip
art. The MORE 3.1 libraries include:

MORE Library contains a variety of templates, rules sets, and
clip art

Color Library 1 contains templates for pictures and color bullet
chart layouts

Color Library 2 contains templates for color bullet chart layouts

B/W Library contains black/white and gray scale bullet chart
layouts

Managers Toolkit 1 contains templates A-Z referenced to in Making
the Most of MORE

Managers Toolkit 2 contains templates AA-HH referenced to in
Making the Most of MORE

Click/Art Library contains Click/Art™ bitmap and PostScript
images

MORE Graph Library contains chart formats for use with MORE Graph

About the MORE 3.1 Libraries

When using the MORE 3.1 libraries, you should know the following:

• Bullet Chart layouts preceded by “B/W” and “Gray” are formatted
for overhead transparencies printed on a LaserWriter.

• Color Bullet Chart layouts are formatted for 8-bit 13" Apple
monitors.
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MORE 3.0 MANUAL CORRECTIONS AND ADDITIONS

After the MORE 3.0 manuals were printed, some features were added or
changed in the program too late to be added to the manual. This section
updates the MORE 3.0 manuals with the most current information.

◆  MORE Memory Requirements

After MORE is installed, you might want to configure how much memory
the program uses when running. This might be especially important
when running MORE under MultiFinder where several applications might
be sharing the computer’s memory.

By default, MORE allocates 1250K of memory to itself when running
under MultiFinder. Depending upon how MORE is being used, the
memory requirements can be adjusted. Here are some suggested
guidelines for allocating memory.

Minimum Memory Requirements

Recommended minimum memory allocation ............................. 750K

Absolute minimum memory allocation ....................................... 550K

Usage Memory Requirements

Outlines only ................................................................................. 800K

Very large outlines (larger than 200K) ...................................... 1024K
   or many outlines open at once

Tree charts and outlines ............................................................. 1024K

Bullet charts ................................................................................ 1024K

Very large bullet charts .............................................................. 1200K
    (usually containing bitmap or PostScript images)

Print preview or browser ........................................................... 1024K
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NOTE: If you are using MORE 3.1 under System 7.0, you can use
Virtual Memory to increase the amount of memory available
to your computer. See the section, “System 7.0 Features”
for more information.

To Change the Memory Allocation:

1. Click on the MORE icon in the Finder. The MORE icon should
appear highlighted.

2. Choose Get Info from the File Menu.

3. Change the Application Memory Size (or Current Size if using
System 7.0) by typing in the desired memory allocation in
kilobytes.

4. Close the Get Info box.

◆  Printing Large or Complex Polygons

Due to limitations with the PostScript implementation on an Apple
LaserWriter, problems can occur when printing very large or complex
polygons with a gradient fill. When trying to print such an object, a
PostScript “limitcheck” error is displayed and Print Monitor reports that
the file is OK, but cannot be printed. If such an error occurs, try the
following:

1. Cancel the printing from the Print Monitor.

2. Restart the LaserWriter. (The LaserWriter doesn’t seem to recover
well from this type of error).

3. Change the large or complex polygon object to a standard
pattern fill.

4. Print the file again.

NOTE: This problem is printer dependent. If you are using a
PostScript printer, other than the Apple LaserWriter, the
problem may not occur. This problem should not occur
with complex imported polygons, such as traced bitmaps.
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◆  Printing Large or Complex Bezier Curves

If there is any problem printing a large or complex bezier curve on a
PostScript printer, MORE automatically makes an adjustment to the bezier
objects. MORE prints the bezier objects with about half the fill color. This
keeps any error messages from being displayed due to the PostScript
implementation on the printer.

◆  PICT Exporting

When exporting MORE objects to a PICT file, PostScript commands are
embedded in the PICT image. Due to the PostScript implementation in
some PostScript printers, printing a PICT file can cause a “Limitcheck”
error. If a “Limitcheck” error is displayed while printing, follow the steps
in the previous section, “Printing Large or Complex Polygons” for
instruction on how to print the files.

◆  EPSF Importing

MORE only imports an EPSF file. The MORE documentation is incorrect
in suggesting that you can export any MORE objects to an EPSF file.

◆  Creating a Multi-line Headline

MORE allows you to create multiple lines in a headline. To break a
headline, position the cursor in the headline, then press o r.
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◆  Drawing and Printing a Portion of a Tree Chart

There may be times when you want to print only a part of a tree chart.
To do this, go to the Outline view. Position the cursor  where you want
to begin drawing the Tree Chart. Press o w J and MORE automatically
jumps to the Tree View and creates the tree chart with the selected
headline as the root of the tree.

◆  Drawing a Scatter Chart in More Graph

A scatter chart is a chart available in MORE Graph that is used to plot
points on an X and Y Axis. The following illustration is an example of a
typical scatter chart.

To draw a scatter chart in MORE Graph, follow these steps:

1. Open a worksheet in MORE Graph.

2. In the first column, enter the numbers for the X-axis. For
example, enter 1, 2, 3 and so on. These are the title points.

3. In the column to the right of the title points, enter a single
column of data. These are the scatter (or data) points.

4. Drag to select the title points, then choose Title Cell from the
Format Menu.

5. Drag to select data points for the Y-axis of the scatter chart.

6. Choose the Scatter Chart icon from the Chart Menu (as shown on
the right).

MORE Graph
Scatter Chart
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◆  Opening Files Created in Other Programs

When opening files created by other programs, the default file type is set
to Any Available. When Any Available is selected, MORE opens the file
as long as the translators are installed or built-in. The built-in file
translators include  MORE 2.x, MORE 3.x, and Plain Text.

If you select a specific file type, MORE uses that file type for the duration
of the session (or until you select another file type). Restarting MORE
reverts the file type to Any Available.

◆  A List of MORE Files

The MORE installer copies the MORE Program files to their proper
location on the hard drive. To relocate any of the MORE files, use the
guidelines in the following sections.

NOTE: Do not rename the MORE Files folder if you are storing the MORE
translator files (i.e. MORE3.MacWrite) in that folder. If you do,
MORE cannot locate the files.

Configuring MORE Translators and More Graph Libraries

The MORE Translators and the MORE Graph Library must be in one of
the following locations:

• in the MORE Files folder within the folder containing the
MORE 3.1 application;

• in the MORE Files folder within your System Folder;

• at the root level of your System Folder.

NOTE: If translators are located at the root level of the system
folder, the MORE Files folder should not be placed in the
System Folder or in the folder containing the MORE
application.  It may be located anywhere else on your hard
disk.
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Configuring Autographix

If you will be sending slides to Autographix®, the Autographix 3.0 driver
must be located at the root level of your System Folder (or the Extensions
folder if using System 7.0), so it can be accessed from the Chooser.

Configuring Other Files and Utilities

The following files and utilities may be located anywhere on your hard
disk:

• MORE 3.1 application

• MORE Graph application

• MORE Tutorial Folder

• MORE Mover Utility

• AGXit!  Communication Utility

The following utilities may be located anywhere on your hard disk.
However, if they are not located in the MORE Files folder, the MORE
application folder, the System folder, or the Extensions folder, MORE asks
for their location the first time you start the program. MORE remembers
the location for subsequent starts. Aliases of these files may also be used.

• MORE Help File

• MORE Dictionaries

• MORE Libraries

• MORE Balloons
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COMMON QUESTIONS AND ANSWERS ON USING
MORE

Q Can bullet charts be generated from the currently selected
headline? Pressing w I, clicking the bullet chart icon, or choosing
Bullet Chart from the Outline Menu gives me a series of bullet
charts generated from the entire outline.

A To create a series of bullet charts whose first chart is the
currently selected headline, press o w I, or hold down the
Option key while clicking the bullet icon. The headline must
have subordinate headlines or the bullet chart starts with the
parent headline. Subheads must be set to First level only. To do
this, choose Subheads from the Bullet Menu in Bullet Chart view.

Q Can a tree chart be generated whose summit node is the currently
selected headline? Pressing w J, clicking the tree chart icon, or
choosing Tree Chart from the Outline Menu gives me a tree chart
whose summit node is the home headline of the outline.

A To create a tree chart whose summit node is the currently
selected headline, press o w J, or hold down the option key
and click the Tree Chart icon. The headline must have
subordinate headlines or the bullet chart starts with the parent
headline. Subheads must be set to First level only. To do this,
choose Subheads from the Bullet Menu in Bullet Chart view.

Q How can I get a Full View comment (document) window?

A The Hoist command on the Outline Menu displays the currently
selected comment window in full view. You might also use the
keyboard commands w H (for Hoist) or s-Enter.

Q Why does text seem to run together on screen, but  print correctly?

A MORE supports fractional widths, which is important for kerning
(kerning is the spacing between characters when printing to a
laser printer). For on-screen work, it may be easier to view the
characters after disabling fractional widths. To disable fractional
widths, choose Document Options from the Window Menu, and
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deselect Use Fractional Widths. Remember to enable fractional
widths before printing to a laser or PostScript printer.

NOTE: Some pre-System 6.0 and shareware fonts do not support
fractional widths, and are badly distorted by enabling
fractional widths.  If you are using any of these fonts, be
sure to disable fractional widths.

Q Is there an easy way to modify an on-screen presentation for a
different output device?

A MORE includes an Adjust command, which automatically adjusts
the size and/or positioning of objects and text when changing
the Chart Size. To use the Adjust command:

1. Enter the Bullet Chart view of the file you want to modify.

2. Choose Chart Size from the Bullet Menu.

3. Select the desired size from the Chart Size popup menu.

4. Click OK.  The Adjust dialog appears after changing the chart
size.

5. Select the desired options, and click OK.

NOTE: Symantec recommends reviewing the adjusted slides for
any modifications they might need.


